Introduction to Visual Basic

Microsoft Visual Basic development system version 6.0 is the most productive tool for creating high-performance components and applications. Visual Basic 6.0 offers developers the ability to create robust applications that reside on the client or server, or operate in a distributed n-tier environment. Visual Basic 6.0 is the Rapid Application Development (RAD) tool available either as a stand-alone product or as a part of the Visual Studio 6.0 suite of tools.

Hardware & software requirements

The following configuration is recommended:
1. Windows NT 4.0, Windows 95/98 operating system.
2. PC with an Intel Pentium processor
3. At least 32 MB of RAM (16 MB for Windows 95 or later)
4. Microsoft Internet Explorer version 4.01 or later.
5. Atleast 50MB of disk space

Editions of VB 6.0

1. Learning
   Consists of all necessary tools required to build main stream Windows Applications

2. Professional
   Includes advanced features such as tools to develop ActiveX and Internet controls.

3. Enterprise
   In addition to all Professional features, it also includes tools such as Visual SourceSafe and the Automation and Component Manager.

Features of visual basic

Basic Features

- Form designer
- Create user Interface using design tools
- Add drawings to the forms
- Set properties for the individual object on the form
- Build an executable file
- Debug the applications
- Examine the objects in the forms
- Work with data in the programs (ODBC)
- Add more functionality to the program by writing code
- Create crystal Repots
# Comparison between Access and Visual Basic

<table>
<thead>
<tr>
<th>Features</th>
<th>Access</th>
<th>Visual Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Designer</td>
<td>Available</td>
<td>Available with more advanced tools</td>
</tr>
<tr>
<td>Design Tools</td>
<td>Available</td>
<td>Available with much enhanced tools</td>
</tr>
<tr>
<td>Add drawings to the forms</td>
<td>Can be done</td>
<td>Can be done with more options</td>
</tr>
<tr>
<td>Setting properties of the individual object on the form</td>
<td>Is possible</td>
<td>Can be done in an easier manner and more properties available</td>
</tr>
<tr>
<td>Building an Executable</td>
<td>Executable can be made with add-on utility</td>
<td>Utility for building executable is there with software</td>
</tr>
<tr>
<td>Debug the applications</td>
<td>Not present</td>
<td>This facility is available</td>
</tr>
<tr>
<td>Examine the objects in the form</td>
<td>There is no option by which we can see all the objects at one place</td>
<td>Object Browser is there to see all the objects at one place along with there methods and procedure</td>
</tr>
<tr>
<td>Work with data in programs (ODBC)</td>
<td>Is there</td>
<td>Is there with more options for drivers</td>
</tr>
<tr>
<td>Add more functionality to the program by writing code</td>
<td>Code can be written using Visual Basic which is altogether is a different software</td>
<td>Visual basic itself is used for writing code</td>
</tr>
<tr>
<td>Create crystal reports</td>
<td>Not available</td>
<td>Is available as Add-on with Visual Basic</td>
</tr>
</tbody>
</table>
Advanced features

- Integrate Visual database tools

  Visual Basic 6.0 provides a complete set of tools for integrating databases with any application. Database features include design tools for creating and modifying Microsoft SQL Server, Oracle 7.3.3 or above, and AS/400 databases.

- DataEnvironment designer for data connectivity

  Visually create reusable recordset command objects with drag-and-drop functionality. Bind to multiple data sources for data aggregation and manipulation.

- Drag and drop creation of data bound forms and reports

  Using the new Data Environment designer, developers can quickly drag-and-drop custom data-bound controls to create forms; they can create reports with the new Data Report Designer. Creation of custom data hierarchies is as easy as filling out a dialog box and dragging the command to the form.

- Visual Basic Web class Designer

  Create server-side applications and components that are easily accessible from any Web browser on any platform.

- Dynamic HTML Page Designer

  Develop multimedia-rich applications using the document object model and Dynamic HTML surface as the user interface.

- New performance enhancements

  Use new String Functions and features such as "Retain in Memory" to create faster, more scalable applications and components.

- The ActiveX Technology

  It is used to create Internet Enabled applications that are limited only by your imagination. Its come with several controls that allow you to create Web Based application.
Visual basic environment (IDE)

When using Visual Basic, the most important skill you need to adopt at using the development environment. Without the integrated tools in the environment, VB programming would be much more cumbersome and difficult. All design would need to be done on graph paper and flow charts, and it would need to be typed in line by line. Fortunately, VB contains many integrated tools to make the application development process simpler. This collection of tools makes up the integrated development environment (IDE).
Forms Window

This is where you design your form. A form is what you will present to a user of your application. A form could be an introduction screen, it could be a dialog box giving the user options, it could be a box containing a warning. All of your VB programs will revolve around a number of forms.

The Toolbar

The toolbar provides quick access to commonly used commands. These will be explained later in the document.

The Toolbox

This floating window provides the tools for designing/creating an application on your form. They can create buttons, text boxes, labels, scroll bars and other commonly used windows items.

The Property Window

All items placed on a form have properties (explained in further detail later on) such as the colour of a button, what type of border a text box has or what font a label is displayed in.

The Project Window

A project is a complete application; this includes all the forms, programming code and other files needed to run this application.
Details of the icons on the toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Standard EXE Project" /></td>
<td>Add Standard EXE Project</td>
<td>This button will create a new project in VB. It will also create a new ActiveX EXE, ActiveX DLL or an ActiveX Control (none of these are covered in this course).</td>
</tr>
</tbody>
</table>
| ![Add Form](image) | Add Form | Adds a new form to your project. This button will also add a new:  
- **MDI Form** (Where you can have multiple instances of the same form on the screen)  
- **Module** (A module contains general programming code independent of specific forms and controls. It contains things like variable declarations, constants, and user-defined sub-programs. Modules can be used in more than one application)  
- **Class Module**  
- **User Control**  
- **Property Page**  
- **User Document**  
You can also add an ActiveX designer application to VB or add an existing form, module, or other file to the current project using the Add File... command. |
<table>
<thead>
<tr>
<th>Menu Design Window</th>
<th>Opens a window that lets you define your own menu systems for your applications. This is the same as going to the Tools menu and choosing the Menu Editor... command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Project</td>
<td>Opens a previously saved application (applications are called Projects). This is the same as going to the File menu and choosing the Open Project command.</td>
</tr>
<tr>
<td>Save Project</td>
<td>Saves the current application/project. This is the same as going to the File menu and choosing the Save Project command.</td>
</tr>
<tr>
<td>Cut, Copy and Paste</td>
<td>These are standard windows application buttons and work as in all Microsoft products.</td>
</tr>
<tr>
<td>Find</td>
<td>This is useful for finding keywords in code.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undoes the last action that you performed. It is not available if there is nothing to undo.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redos the last action that was undone.</td>
</tr>
<tr>
<td>Start</td>
<td>This will execute the current application (or resume a suspended one). It places you in Run mode. It is the same as going to the Run menu and choosing Start or Continue.</td>
</tr>
<tr>
<td>Break</td>
<td>This will pause the current application and will place you in Break mode. You can then test the program, using the debugging tools, to see if it is working correctly. You can also do this by going to the Run menu and choosing the Break command. To resume the application click on the Continue (the Start) button on the toolbar.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>This will end the current running application and return you to <strong>Design</strong> mode. You can also do this by going to the <strong>Run</strong> menu and choosing the <strong>End</strong> command.</td>
</tr>
<tr>
<td><strong>Project Explorer</strong></td>
<td>Displays the <strong>Project</strong> Window, which lists all of the files used in your application.</td>
</tr>
<tr>
<td><strong>Properties Window</strong></td>
<td>This activates the Properties Window. You use the Properties window to assign attributes to items on a form. This is the same as going to the <strong>Window</strong> menu and choosing the <strong>Properties</strong> command.</td>
</tr>
<tr>
<td><strong>Form Layout Window</strong></td>
<td>This shows the <strong>Form Layout Window</strong>, which lets you determine the starting position of your form relative to the screen.</td>
</tr>
<tr>
<td><strong>Object Browser</strong></td>
<td>Brings up the <strong>Object Browser</strong>, which is used for finding out about objects, properties and methods (described later in this manual).</td>
</tr>
<tr>
<td><strong>Toolbox</strong></td>
<td>This displays the <strong>Toolbox</strong> on the left of the screen. The Toolbox contains the objects that can be drawn on your form.</td>
</tr>
<tr>
<td><strong>Data View Window</strong></td>
<td>This allows you to view all of the databases that you are connected to. You can see their tables, queries and other useful items.</td>
</tr>
<tr>
<td><strong>Visual Component Manager</strong></td>
<td>This will help advanced users to organise and sort their visual studio projects better.</td>
</tr>
</tbody>
</table>
Visual Basic Project

What is Visual Basic Project?

Visual basic project basically consists of three parts -- the *user interface*, the *processing of information*, and the *storage of information*.

The *user interface* is the part of the program that your users see and with which they interact. This user interface is composed of the screens you design by using Visual Basic's forms and controls.

The *processing of information* is done by the set of statements written to add the functionality to the object.

The *storage for Information* is generally any backend Database, which is connected to frontend by any of the standard Data Control or through Designers.

Following are the Modules which are available in Visual Basic project to perform the above three tasks:

1. **Form Module**: It contains the graphic elements of the VB application along with the instruction.

2. **General Module**: It contains general-purpose instructions not pertaining to anything graphic on-screen

3. **Class Module**: It contains the defining characteristics of a class, including its properties and methods

4. **Global Module**: It contains declaration and procedures

5. **Resource Files**: It allows you to collect all of the texts and bitmaps for an application in one place

When you start VB for the first time project wizard will be opened and following project templates will be displayed

- **Standard EXE**: It is a typical Application.
- **ActiveX EXE, ActiveX DLL**: Available with Professional Edition. ActiveX components are basic code-building elements that don’t have a visible interface and that can add functionality to your applications.
• **ActiveX Control**  
  Used to develop your own ActiveX controls. It is a basic element of the user interface. If the ActiveX control that comes with Visual Basic don’t provide the required functionality then custom ActiveX controls can be build.

• **ActiveX Document DLL, ActiveX Document EXE**  
  ActiveX documents are in essence Visual Basic applications that can run in the environment of a container that supports hyperlinking

• **VB Application Wizard, VB Wizard Manager**  
  The Application Wizard takes through the steps of setting up the skeleton of a new application like a template in any MS-office component where basic structure is readily available and changes can be made depending on the need.  
  Whereas VB Wizard Manager helps in building our own Wizard which is a sequence of windows that collects information from user required for building an application.

• **Data Project**  
  This is a feature of enterprise edition that automatically adds the controls that are used in accessing databases to the Toolbox

• **DHTML Application**  
  Allows to build Dynamic HTML pages that can be displayed in the browser's window on a client computer. It helps user in viewing the data lying with any RDBMS package at the backend and can also edit that and can do the queries also through browser itself.

• **IIS Application**  
  Allows to build applications that run on the Web server and interact with clients over the Internet with Internet Information Server

• **Add-In**  
  Own Add-Ins can be created for the Visual basic IDE. Add-Ins are special commands that can be added to Visual Basic menus

• **VB Enterprise Edition Control**  
  It simply creates a new Standard EXE project and loads all the tools of the Enterprise Edition
Steps for building a Visual Basic Application

After designing the application, for building an application in Visual Basic following steps are to be taken:

1. **Draw the Interface**
   - Create the form and the various objects on the form using toolbox.

2. **Set the Properties**
   - Set the properties of the various objects on the form with the help of properties window.

3. **Write the events code**
   - In the code window, write the code associated with each object on the form and then run the application.
Few Examples to start with Visual basic

How to Start a project

- Start the visual basic by clicking **Start>>Programs>>Microsoft Visual Studio 6.0>>Microsoft Visual Basic**
- Choose **Standard EXE** from the available screen
- Click **Open**.
- A blank form will appear on the screen with **Project Explorer Window, Properties Window and Tool Box**.

Example 1: This example is to print a text in the text box by clicking on the button.

With the help of Tool Box given on the left side of the interface, draw the following interface:
Set the properties of the objects on the form as given in the table below:

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box</td>
<td>Text1</td>
<td>Text</td>
<td>&lt;Blank&gt;</td>
</tr>
<tr>
<td>Command Button</td>
<td>Command1</td>
<td>Caption</td>
<td>Click here</td>
</tr>
<tr>
<td>Command Button</td>
<td>Command2</td>
<td>Caption</td>
<td>Stop</td>
</tr>
</tbody>
</table>

Double click **First Command Button** and write the following lines of code:

```vba
Private Sub Command1_Click()
    Text1.Text = "Welcome to Visual Basic"
End Sub
```

Click **View Object** to come back at the form.

Double click **Second Command Button** and write the following lines of code:

```vba
Private Sub Command2_Click()
End Sub
```

Run the project by clicking **Run>>Start** or Press **F5**.

Save the project by clicking **File>>Save Project**.

Specify the folder in which all the files like form, reports etc. related with the project along with the project name are to be saved.

*Note: It is advised that one folder for each project should be created.*
Example 2: This example is to calculate the simple interest to be paid on the given principle amount, rate of interest and the number of years.

- Create a new Standard EXE Project by clicking on File>>New Project and then following the steps given in example 1.
- Draw the interface as given below using the same Tool Box.

<table>
<thead>
<tr>
<th>Object</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text1</td>
<td>Text</td>
<td>&lt;Blank&gt;</td>
</tr>
<tr>
<td>Text2</td>
<td>Text</td>
<td>&lt;Blank&gt;</td>
</tr>
<tr>
<td>Text3</td>
<td>Text</td>
<td>&lt;Blank&gt;</td>
</tr>
<tr>
<td>Text4</td>
<td>Text</td>
<td>&lt;Blank&gt;</td>
</tr>
<tr>
<td>Label1</td>
<td>Caption</td>
<td>Principal Amount</td>
</tr>
<tr>
<td>Label2</td>
<td>Caption</td>
<td>Rate of Interest</td>
</tr>
<tr>
<td>Label3</td>
<td>Caption</td>
<td>Number of Years</td>
</tr>
<tr>
<td>Label4</td>
<td>Caption</td>
<td>Interest to be paid</td>
</tr>
<tr>
<td>Command1</td>
<td>Caption</td>
<td>Calculate</td>
</tr>
</tbody>
</table>

- Double click Command1 and write the following line of code:
- Run the Project and enter the values and then click the command button to see the result.
Few Definitions to remember

Few technical terms that will be used in the development of Visual Basic Project very often:

- **Controls** Reusable objects that provide the pieces of the visual interface of a program. Examples of controls are a text box, a label, or a command button.

- **Event** An action initiated by the user, the operating system, or the program itself. Examples of events are a keystroke, a mouse click, the expiration of a specified amount of time, or the receipt of data from a port.

- **Methods** Predefined actions that can be performed by an object. For example, a form has a `Hide` method that makes it invisible to the user.

- **Object** A basic element of a program, which contains properties to define its characteristics, contains methods to define its tasks, and recognizes events to which it can respond. Controls and forms are examples of the objects used in Visual Basic.

- **Procedures** Segments of code that you write to accomplish a task. Procedures are often written to respond to a specific event. Types of procedures include Sub procedures, which consist of a sequence of statements; and Functions, which return a value.

- **Properties** The characteristics of an object, such as its size, position, color, or text font. Properties determine the appearance and sometimes the behavior of an object. Properties are also used to provide data to an object and to retrieve information from the object.